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1. PC Software Installation
1.1 System Requirements

•  MARS was developed to operate with Windows 98, 2000, ME, XP.
•  Pentium-based CPU, minimum.  High speed CPU is recommended for faster

performance.
•  32 MB minimum, 64 MB or higher recommended for higher performance.
•  2-button mouse.
•  Monitor specifications:

Minimum: 15” Monitor @ 1024 x 768, 256 color, normal font size setting.
Recommended: 17" monitor @ 1024 x 768, 256 color, normal font size setting.
Note: If large fonts are set, the complete MARS screen may not be displayed on smaller
monitors.

•  Network Interface Card, PCI or ISA
(for communication with MARS via TCP/IP protocol)

•  *Modem (a hardware modem -- ISA bus modem is recommended for more reliable
performance).

•  *Analog phone lines (PBX not recommended).
*Note: Modem and phone lines are required only if communication via modem/phone lines
is desired.

1.2 Software installation
•  Insert MARS CD into CD-DRIVE.
•  Close all other window applications currently running on your system.
•  Select "Run" from the "Start" menu and browse the CD for "setup.exe".
•  Select "OK" and follow the instructions within the set-up procedure. Default installation

directories are recommended.

NOTE: MARS may contain files that are older than those currently installed on your
computer.  It is recommended that the newer files be kept.

2. MARS Hardware installation
2.1 Caution information

•  When handling the MARS hardware it is recommended that a static strap be worn to
prevent damage to components affected by static discharge.

2.2 MARS main module installation
The following installation procedure pre-supposes that that the operator has installed an
evslevslevslevsl MLC chassis with either an MPS or MPSM-9 power supply.

•  Figure 1 depicts the insertion of the MARS module into an empty bay in an evsl MLC
chassis.  The control panel and knob are shown in Figure 2.  (NOTE: The software
version of the control panel must be 3.30 or greater--turning the knob on the MLC
chassis displays the version number).

•  The MARS main module is shipped with operational software but is not configured or
activated by the MARS PC.  In this state MARS cannot monitor any functions or
communicate with a MARS PC.  The PC, however, can connect to and configure the
MARS module.
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•  The MARS module has an LED status indicator (Green/Red) located at the rear of the
MARS module beside the RJ11 Phone input (See Figure 3).  RED indicates that MARS
is connected and transferring data to the PC (via TCP/IP or dialup). GREEN indicates
that MARS is monitoring functions. There are two LED’s on the 10 BaseT input – the
GREEN LED indicates a successful connection to the network, the ORANGE LED
indicates activity.

NOTE: MARS cannot be accessed from the front panel while the indicator is RED
(because communication is in progress with a PC)

             

Figure 1: MARS module Insertion

                     

Figure 2: MLC Chassis, Control panel and Knob
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Figure 3: MARS module rear panel

2.3 MARS external sensor(s)/devices installation
•  External devices, such as temperature, voltage and condition sensors, may be rack-

mounted on an RP8 rack panel (See Figure 4).  Alternately they may be mounted on a
wall or ceiling using a single module L-bracket as shown in Figure 5.

•  Up to 8 external temperature sensor modules and 8 voltage sensor modules may be
monitored by one MARS module.

•  MARS may monitor only 1 external condition sensor.  The condition sensor can sense
up to 9 logic states.

Figure 4: MARS sensors mounted on RP8 rack panel
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Figure 5: L-bracket mount for wall or ceiling

•  Up to 8 external addressable power strips (See Figure 6) can be controlled by one
MARS module.  These devices can be mounted directly on a wall, ceiling, etc. or rack-
mounted on a 2 RU panel.

Figure 6: MARS APS-8 (Addressable Power Strip)

2.4 Serial (I2C) connection
•  Analog TV RF, video and audio and QAM RF functions are sensed internal to the

MARS module, with a sample of the combined RF signal being supplied to the MARS
via an F-Connector. Sensing of temperatures, voltages and conditions (logic states) is
done external to the MARS module and communicated to the MARS monitoring
circuitry via a serial I2C1 bus. Control of Addressable Power Strips and Addressable
Switches is accomplished via the same serial I2C bus. (See white cable connections in
Figure 4). All external devices are connected serially using standard flat, 4-conductor
telephone cable and crimped handset plug.  The plugs must be assembled such that the
wire colors are ordered alike when the plugs are observed in the same view. (See
Appendix B for I2C cable assembly instructions.)  Connect one of the devices to the
MARS module handset jack located on the rear panel.  Each external sensing or control
device has one or more LED indicators which will illuminate (Green or Red) upon
insertion of the handset plug indicating successful connection and the presence of +5
volts I2C bus power.

                                                          
1 I2C: Inter-Integrated Circuit (a 2-wire bus specification developed by Philips Semiconductor)
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2.5 RF input connection
•  Using a standard RG-59/RG-6 cable, connect the combined CATV/QAM RF output to

the F-connector located on the rear panel of the MARS module (see Figure 3). See 3.2
RF levels for setting the RF level to the MARS input at the proper level.

2.6 Modem connection
•  Connect a standard telephone cable from a wall jack to the RJ11 input of the MARS

module (located below the ‘Phone’ label, see Figure 3).

2.7 Ethernet connection
•  Connect a Category 5 cable from the 10BaseT input on the MARS module to an

available access point (such as a hub, switch or router/gateway) on a Local Area
Network (LAN) or Wide Area Network (WAN). Note that a GREEN LED on the
10BaseT input indicates a successful connection to a network. The ORANGE LED on
the 10BaseT input indicates activity.

3. MARS Hardware setup
3.1 Setup of sensor and control modules

•  The sensor module’s address can be set through an access hole  located on one side of
the module’s chassis (See Figure 7, below).

•  The device address of the temperature and voltage sensor modules must be set for
MARS to properly read and configure each module.  Devices of the same function set to
the same address will produce an I2C bus conflict, thus affecting other MARS
operations.  Insert a small, flat screwdriver into the slot of the octal selector switch and
set devices of the same function to different addresses.

Figure 7: Sensor module showing address selector

•  The condition sensor uses the same type of switch to configure the 9th (auxiliary) input
(There is only one fixed address for this device).  The following options are available:
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SW0: Aux input trips on ACTIVE HIGH signal; buzzer is DISABLED
SW1: Aux input trips on ACTIVE LOW signal; buzzer is DISABLED
SW2: Aux input trips on ACTIVE HIGH signal; buzzer is ENABLED
SW3: Aux input trips on ACTIVE LOW signal; buzzer is ENABLED
SW4: Aux input trips on ACTIVE HIGH; buzzer is DISABLED; Faults are LATCHED
SW5: Aux input trips on ACTIVE LOW signal; buzzer is DISABLED; Faults are
LATCHED
SW6: Aux input trips on ACTIVE HIGH signal; buzzer is ENABLED; Faults are
LATCHED
SW7: Aux input trips on ACTIVE LOW signal; buzzer is ENABLED; Faults are
LATCHED

3.2 RF levels
•  The RF input should ideally be equal (flat within +/- 3dB) for all analog TV channels.

The nominal level can be from +10 dBmV to +25 dBmV per carrier with an ideal range
of about +15 dBmV +/- 3dB. QAM RF levels are typically about 7 to 10 dB lower than
analog TV RF levels and the MARS is designed to handle QAM signals at these levels
relative to the analog channels.

NOTE: Large RF level deviations from nominal will produce inconsistent alarm conditions.
Ensure that the RF levels of all channels are within +/- 3dB of nominal at the MARS RF
Input.

3.3 Configuring MARS
The operator may choose to configure MARS functions from either the eML MLC control
panel or from a remote PC equipped with the MARS Master software.

3.3.1 Configuring MARS Functions from the control panel
The MARS control panel enables you to automatically detect the presence of
operating functions (with the exception of QAM) at the MARS site. Once this
configuration is detected, it can be sent to the PC, thereby avoiding the manual entry
of this configuration at the PC (although manual entry at the PC is still an option).
See 4.8.3 Enabling Auto-configuration from MARS to PC for instructions on
how to update the PC with the MARS configuration following an auto-detect from
the front control panel.
Note: The auto-detection from the front control panel configures operating
functions only. Further configuration settings are required at the MARS site and on
the MARS PC’s in order for the system to become fully operational.

Note: operation of any module in the MLC (Modular Line Chassis) is accomplished
by: 1. Rotating the MLC control knob to highlight a selection or adjust a parameter,
then 2. Pushing the MLC control knob to “select” or “store” it.

To configure the MARS functions using auto-detect:
•  Select the bay in which MARS is inserted (the bay number is marked on the

front of the chassis).
•  Select "Channels/Det CATV" for MARS to detect all valid CATV channels.  A

message will appear on the control panel LCD informing the operator that
channels are being detected (push the control knob at any time to stop auto-
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detection). After completing the process, MARS displays the status of detected
channels (hi-lighted) over several screens.  Turn the knob to view subsequent
screens.  Push the control knob to exit the "View screen". Select "Go Back" to
return to the previous menu. The channel status can be viewed at any time by
selecting "Channels/CATV".

•  Select "Channels/QAM" to view configured QAM channels.  QAM channels can
be viewed via the MLC control panel, but cannot be automatically detected via
the MLC control panel.  They must be configured from the MARS PC.

NOTE: A channel will not be configured as part of the auto-detect configuration if
any one of RF, video or audio is absent. The channel can, however, be entered
(configured) from a PC operating the Master Software.

•  Select "Temp/Detect" to detect all valid temperature modules.  A momentary
lapse will take place prior to displaying the temperature status results.  Rotating
the control knob selects the next detected temperature module (hi-lighted).  The
current temperature and temperature trip value for each detected temperature
module can be read at the bottom of the screen.  Push the control knob to exit the
"View screen".  Select "Go Back" to return to the previous menu.  The
temperature status can be viewed at any time by selecting "Temp/View".

•  Select "Voltage/Detect" to detect all valid voltage modules.  A momentary lapse
will take place prior to displaying the voltage status results.  Rotating the control
knob selects the next detected voltage module (hi-lighted).  The current status of
each module is displayed at the bottom of the screen.  "On" indicates that the
main or auxiliary function is detected and operating.  "Off" indicates that the
main or auxiliary function is detected, but the voltage is removed from that
sensor.  "---" indicates that the main or auxiliary function is not detected.  Push
the control knob to exit the "View screen".  Select "Go Back" to return to the
previous menu.  The voltage status can be viewed at any time by selecting
"Voltage/View".

NOTE: AC/DC voltage must be available at the Voltage Sensor for MARS to detect
the modules (See Appendix C, Specifications, for voltage range).

•  Select "Cond'n/Detect" for MARS to detect valid inputs to the condition sensor.
A momentary lapse will take place prior to displaying the condition status
results. Rotating the knob selects the next input and displays the alarm status (hi-
lighted). The status of the selected input is "True" if the input is valid and
"False" if invalid.  The auxiliary input is viewed as a separate entity at the
bottom of the screen.  It will display "---" if not detected.  Push the control knob
to exit the "View screen".  Select "Go Back" to return to the previous menu.  The
condition sensor status can be viewed at any time by selecting "Cond'n/View".

NOTE: A valid logic-level input must be present for MARS to detect the condition
module inputs.
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3.3.2 Configuring MARS from the PC
•  To configure MARS from the PC, select "SYSTEM" from the MLC control

panel and ensure that MARS is “ENABLED”. Proceed to item 3.4 Configuring
MARS TCP/IP Communication Parameters.

3.4 Configuring MARS TCP/IP Communication Parameters
The MARS needs to be assigned an IP Address and port number before it can
communicate. The MARS is shipped with a default IP address of 192.168.1.253 and a
default port number of 21. The IP address and port number can be set or changed via the
front control panel on the MARS itself, or, optionally, from the PC once the MARS PC
software is installed (See 4.8 Advanced Features and Settings).
To set the IP address and port number from the front control panel, rotate the MLC control
knob to view the menu, then select the bay that the MARS module is installed in. Select
“System” then “TCP/IP”. The IP address and port number will be displayed. To change
the IP address, press the knob to highlight the first digit in the IP address, rotate the knob
to change the value, then  press the knob to set the value. (Note: all numbers less than
three digits need to be padded with zero’s to make three digits. For example, the number
65 must be entered as 065 and the number 5 must be entered as 005). When the knob is
pressed, the next digit in the IP address will be highlighted. Repeat the process with the
remaining digits in the IP address. When the knob is pressed to set the last digit, the
display will show the message “SAVING…” at the top. Wait until this message
disappears. When the message disappears, the setting has taken effect.

4. PC Software setup
PC software must be configured in order to communicate with a MARS site.  Follow the
subsequent procedures for PC software setup.

4.1 Setting Options
•  A minimal options configuration is required before the PC can communicate with

MARS.  Start the MARS application on the PC. The MARS Diagnostic Utility (MDU)
screen will appear (See Figure 8, below). Select "Options..." from the Tools menu on
the MDU screen. The Options Form will appear (See Figure 9, below)

•  Under the "General" tab browse the default database path required to open the database.
•  If modem communication is to be used,

! Under the "Modem Settings" tab click the radio button under "Port" that associates
with your computer's modem port setting.
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•  Since all other features under the "General" and "Modem Settings" tab are optional,
select "Save" to store the current options configuration. Keep the options form open and
proceed to 4.2 Entering Password Information, below.

Figure 8: MARS Diagnostic Utility (MDU) main screen

Figure 9: Options Form, General Tab



evsl MARS
Installation and Operation Manual

Ver 2.0 Printed in Canada
Page 13 of 31

4.2 Entering Password information
•  Passwords are required to access various features of the MARS. The ‘user’ and

‘administrator’ passwords control access to the MARS application on the PC while the
TCP/IP username and password control access the remote MARS site(s). More
specifically, the ‘user’ password allows access to the MARS database on the PC and, in
combination with the TCP/IP username and password, allows the monitoring of the
MARS site and ‘cycling’ of power strips on site. The ‘administrator’ password allows
full access to the configuration of the MARS application on the PC and, in combination
with the TCP/IP username and password, allows the monitoring and full configuration
of the MARS site.

•  Before MARS operations can begin, new passwords must be entered.

Note: Alpha characters ARE NOT case sensitive for the user and administration password.
However, they ARE case sensitive for the TCP/IP username and password.

•  To enter a new password, there must be either a current, valid password or the password
must be cleared.  If valid password currently exists, then skip the instructions on
clearing the passwords that follow.

•  To clear the password(s), ensure the database is closed (If the database is not closed,
then close the database by selecting “Close Data Base” from the File menu), then select
"Tools/Password Administration" from the MDU screen. After the Password
Administration window appears (See Figure 10, below), enter the product ID and click
"Submit" to enable the check boxes for clearing password(s).  Check the boxes
according to what you wish to clear, and then select "OK".  The password(s) will be
cleared after selecting "Yes" to the subsequent dialogues. Note: clearing the TCP/IP
Username/Password clears the username and password at the PC only – it does not clear
the username and password at the MARS.

           Figure 10: Password Administration Form

•  To enter passwords for the MARS application:
On the Options form, select “MARS Security” (See Figure 11, below).
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        Figure 11: Options Form, MARS Security Tab

If passwords have been cleared in the previous step above:
For each password or username, leave “Old Password” blank and enter in the “New
Password” and “Confirm Password” with a minimum of four and a maximum of 10
alphanumeric characters. Click “Save” and then click “Yes” to save the new
password.

If passwords have not been cleared and existing passwords are known:
For each password or username, enter in the “Old Password”, “New Password” and
“Confirm Password” with a minimum of four and a maximum of 10 alphanumeric
characters. Click “Save” and then click “Yes” to save the new password.

•  After entering the password(s), select “Close” to close the Options form.

4.3 Opening the Database
•  After the user password is configured and the default database path is set in the

"Options" form, the operator can open the database.
•  From the main MDU screen, select "Open Database" or select a recent file from the

“File” drop down menu.
•  Enter the USER or ADMINISTRATOR password and press "ENTER" or select "OK".
•  If “Open Database” was selected, browse to the location of the database, select the file,

then select “Open”.
•  The name of the opened file will be appended to the "MARS Diagnostic Utility" title bar

located on the top of the MDU screen.  If the database contains status information, the
screen will display status information, otherwise the screen will be blank.

4.4 Creating a Site
•  Prior to configuring a MARS Site, there must be at least one Region created.  Select

"DataBase Manager/Region Manager" from the Tools menu.  Enter the
ADMINISTRATOR password and press ENTER or select "OK".  When the Region

Manager window appears(See Figure 12, below), enter a region name and click "Add".
Select "Close" to exit the Region Manager.
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     Figure 12: Region Manager Form

•  Select "DataBase Manager/Site Manager" from the Tools menu.  Enter the
ADMINISTRATOR password and press ENTER or select "OK".  When the Site
Manager window appears (See Figure 13, below), enter a Site name and select an
associated region from the Region List.

Figure 13: Site Manager Form

•  If modem communication is to be used:
•  Click on the “View Dialup Settings” button to display the dialup configuration

information (See Figure 14, below.). Enter a Site Phone number for the MARS site.
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Phone number have no formatting--whatever is entered will be dialed.  A maximum
of 30 numeric digits can be entered including commas; each comma results in a 2-
second delay (for example, can be useful for dialing 9). This Site Phone number is
all that is required to contact the MARS site. However, if the MARS site is to
automatically report faults to one or more PC’s (up to four PC’s can be reported to),
enter in the phone number(s) and check the “enabled” checkbox for each PC. Note:
A PC that is not listed in the spaces provided can still contact the MARS. The spaces
are provided so that the MARS will automatically contact the listed PC’s in the
event of a fault.

Figure 14: Site Manager Form

•  If TCP/IP communication is to be used:
•  If the TCP/IP settings are not visible, click on the “View TCP/IP Settings” Button

located on the Site Manager Form. Click on the “LAN” or “WAN” radio button
depending on whether the MARS is installed on a LAN or a WAN.

•  Enter the Public IP address beside the “Public IP” label. This is the IP address that is
required to reach the MARS. Enter the MARS IP address beside the “MARS IP”
label. This is the IP address on the MARS module itself. This may be the same as
the Public IP that was specified beside the “Public IP” label.

•  Enter the Gateway IP.  This is the IP address of the gateway or router that the
MARS needs to communicate with in order to reach any Public IP address. The
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MARS module itself is shipped with a default gateway of 192.168.1.1. If the
gateway entered at the PC is differerent than this default gateway, the gateway at the
MARS site will be updated on the next communcation with the MARS site.

•  Enter the Port number that the MARS module is set to. Unless this has been changed
at the MARS since initial installation, the port number that should be entered will be
21. To change the port see 4.8.1 Changing MARS Port from PC which can be
found under the section 4.8 Advanced Settings.

•  If the MARS is to report faults to any PC’s, enter the IP addresses for up to 4 PC’s
in the space provided. Click on the check box beside each PC IP address in order to
enable communication to that PC. Note: All of the PC’s listed must be set to the
same port. Further configuration is required for each PC once the Site Manager form
is closed.

•  Select "Add" then "Close" to exit the site manager.
•  The Region Name and the Site within that region now appear on the main screen.

4.4.1 Automatic Communication from MARS to PC on Fault/Restoration:
In order for the MARS to automatically report faults to a PC listed on the Site
Manager Form, the listed PC must be configured to accept communication from
the MARS site. Select "Internet Configuration” from the Tools menu on the main
MDU screen to view the default settings (See Figure 15, below).

Figure 15: Internet Configuration Form
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By default, the PC accepts communication from the MARS site on Port 21. If you
wish to change any of the default settings, refer to 4.8 Advanced Features and
Settings.

The Internet configuration form also includes an email configuration section that
will allow you to automatically notify up to four recipients by email in the case of
a fault from the Mars. After entering email settings, ensure that the Email
Communication checkbox is selected so that email is enabled. Select “Save email
config’ to save settings. Select the “Hide” Button, to return to the main MDU
screen.

4.5 Configuring the Site
•  Once a Region and Site have been created open the configuration window to enter the

basic information required to configure a MARS Site.
•  Select "Tools/MARS Configuration" from the tool bar.  Enter the ADMINISTRATOR

password and press ENTER or select "OK".  The MARS configuration window appears
(See Figure 16, below).

      Figure 16: MARS Configuration, Channel Monitoring Configuration Screen
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•  Select the Region and Site you wish to configure.  If the MARS site was previously
configured as discussed section 3.3.1 Configuring MARS from the control panel
(allowing MARS to auto-detect the presence of functions) then skip steps 1, 2, and 11,
below. If the MARS site was not previously configured, perform all of the steps below:

1. In the "MARS module--Channel monitoring configuration" frame, select the CATV
channels that MARS should monitor by clicking on the "En" box beside each
channel.  The function of the next two boxes (RVA and Aud) is not required for
minimal setup.

2. In the "Sensors" frame, select the voltage and temperature modules and condition
inputs that MARS should monitor by clicking the boxes beside each number.  The
numbers beside the boxes represent the selected address of each voltage and
temperature module (discussed earlier in 3.1 Setup of sensor modules).  Each
number beside each box of the condition sensor represents a single input.

3. Enter the temperature trip points a few degrees higher than the anticipated normal
operating temperature of each temperature module.

4. Enter "200" in the "RF Threshold" text box. (200 is a "level" that would equate to an
RF input of about +15 dBmV).  A fault will be detected when then RF-level drops
approximately 10 dB.  See Appendix A for a calibration graph of values.

5. Enter a number in the range of 2 to 255, inclusive into the "Max Fault Tx" text box.
When MARS has reached the Maximum number of faults or restorations indicated
in the text box, the PC will instruct the MARS to inhibit further calls for the
remainder of the day.  MARS will reset this status at midnight.  This is useful if you
want to limit the number of fault and restoration reports in a day.

6. Enter number between 1 and 6, inclusive for the "Audio Delay”. With lower
numbers MARS will be more sensitive to intermittent audio lapses. If the MARS
site does not detect the presence of audio within the number of seconds specified, it
will report a fault.

7. Click "Next Page" to advance to the QAM configuration screen (See Figure 17,
below).
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Figure 17: MARS Configuration, QAM Configuration Screen

8. Select the QAM channels that MARS should monitor by clicking on the "En" box
beside each channel.  Note that if a CATV channel is already configured for this
channel, QAM cannot be configured.  Alternately if QAM is previously configured
then CATV cannot be configured for this channel.

9. Enter "225" in the "QAM Threshold" text box (225 is a "level" that would equate to
an QAM RF input of about +8 dBmV).  A QAM fault will be detected when the RF-
level drops approximately 10 dB.  See Appendix A for a calibration graph of values.

10. Click "Next Page" to advance to the Power Strip configuration screen (See Figure
18, below).
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Figure 18: MARS Configuration, Power Strip Configuration Screen

11. This screen allows the configuration of up to 8 Power Strips.  Each Power Strip can
be configured to individually switch 120VAC power to each of its 8 receptacles.
Enable a receptacle by clicking the "En" button associated with that receptacle (the
button will turn GREEN).  Additionally, each receptacle can be ‘cycled’ (turned off,
then on) for a predetermined time. To cycle a receptacle, click the "Sw" button
associated with the receptacle and enter a value between 1 and 255 seconds in the
"Sw Delay" text box. On the next communication with the MARS site, the Power
Strip will remove power from the receptacle for the specified time. (NOTE: After
this command is sent to the MARS site or there is any communication attempt
whether successful or not, all commands to ‘cycle’ Power Strips are cleared. This
provides assurance that a Power Strip will not be cycled unintentionally at a later
time.

12. The "Activate Site" and "De-Activate Site" will be discussed in the next section.
13. Select "Save" to store the selected information in the database.
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Figure 19: MARS Diagnostic Utility (MDU) main screen

4.6 Basic navigation of the MARS Diagnostic Utility (MDU)

To familiarize the operator with the MARS diagnostic screen navigation, a brief description
of the controls follows:

•  The Region can be selected by clicking on the combo box at the upper left corner of
the MDU (See Item   on Figure 19, above). Selecting the region will cause the Site
list box to be filled with associated sites.

•  A Site is selected by clicking a site name in the Site list box.  Selecting a Site causes
the remainder of the screen to be filled with site status information.

•  When a site is selected the “Connect” button is enabled in the TCP/IP section of the
MDU screen. Selecting the “Connect” button will retrieve data from the selected
MARS site (Assuming the site had previously been configured with necessary
parameters).

•  When a site is selected the "Answer" and "Dial MARS" buttons are enabled.
Selecting the "Answer" button allows the PC to receive data from the MARS Sites
via a dial-up connection.  Selecting "Dial MARS" invokes a dial-up connection to
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the selected MARS Site (Assuming the site had previously been configured with
necessary parameters).

•  The main screen is divided up into several sections.  The MARS Power Status,
located near the upper left area of the screen, displays the DC power status to the
MARS module as well as the date and time of the current MARS status. Voltage
status (main and auxiliary) is displayed at the top of the screen, while temperature is
displayed near the bottom of the screen.

NOTE: By moving the cursor over the temperature display boxes, a ToolTip will appear
displaying the current temperature trip point

•  The center section displays the RVA (RF, Video, and Audio) status of all analog TV
and QAM channels for which monitoring has been enabled. QAM channels are
indicated by a “QAM” label beside the channel number.

•  To display the results of the remainder of the channels, select the "Next Status Page"
button located near the bottom right side of the Channel Status section (See Figure 20,
below).

•  In addition to RVA, the second status-page displays the “Alarm Sensors” and battery
status. To return to the first status-page select the “Next Status Page” again.

•  To the left of the “Next Status Page" button is a display of the current status record and
the total number of status records for the selected site.  Clicking the arrows on either
side of the display retrieves previous or subsequent status data.
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Figure 20: MARS Diagnostic Utility (MDU) main screen (‘Second’ status page)

4.7 Activating the MARS Site
•  When a MARS site is created at the PC it is automatically assigned a "Site Code"

that is permanently stored in the database on the PC. The site code cannot be altered.
The Site can be deleted, though, and a new site under the same name can be created
with a different site code.  The same site code can never be duplicated.

•  Select the MARS site for activation.
•  Open the configuration window by selecting “MARS Configuration” from the Tools

menu of the MDU screen. Ensure that the site to be activated is highlighted then
select the "Activate Site" check box, then select "Close" to exit the configuration
window.  Note that "Activate Site" will appear in RED in the "Site Fault Status"
frame on the MDU screen.  The label will disappear after the MARS site has been
activated.

•  If modem communication is to be used:
•  Select "Dial MARS" in the “ModemControl" frame.  The status line under the

control box will reflect the MARS communication status.  After connecting, the
status line will display "Connected".
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•  The user can watch the status window for the message "Activating Site" to
ensure that the MARS site is being activated.  After communication is complete,
the status window displays "Waiting for connection".

•  If TCP/IP communication is to be used:
•  The MARS site is set up with a default username and password for TCP/IP

communication. For site security, it is recommended that the username and
password be changed, immediately. If this has not been done already in section
4.1 Setting Options, see this section for instructions on providing a new TCP/IP
username and password before proceeding.

•  Select the "Connect" button in the "TCP/IP Control" frame.  The Connection log
window will reflect the MARS communication status. The user can watch the
log for the message "Activating Site" to ensure that the MARS site is being
activated.  After communication is complete, the log indicates that the
connection to MARS has been closed.

Note: The message "Activating Site" in the log or status window confirms that the MARS
site has been activated. If it does not appear, the steps must be repeated (the "Activate Site"
check box automatically clears after each communication to prevent accidental re-
configuration of the MARS).

•  Activating the site does not update the database with the next status record.
Following activation, the MARS site must be contacted to receive a status record.
Retrieving a status record indicates that the MARS is configured correctly. To
retrieve a status record, ensure the MARS site is highlighted in the site list box and
then select the “Connect” button. On successful connection, a status record will be
received and the number of status records should increase by one.

•  The MARS site now retains a basic configuration.  Testing automatic
communication from the MARS site may be performed by (for instance) removing
voltage from the power sensor module.  When the data is received by the PC, the
display rectangle next to the selected site will be RED indicating a fault--an asterisk
("*") will also appear beside the associated Region Name in the Region Combo box.
The display rectangle to the left of the region name will also be RED indicating that
there is a fault in the selected region.

•  MARS is now ready for full operation.

4.8 Advanced Features and Settings
MARS has a number of features that allow it to be customized for various installation
configurations. Note that some configuration changes to the MARS site can only be
performed from a PC with the MARS Master software installed.

Note: For all requests to update the MARS site configuration from the PC, it is advisable to
confirm that the request was sent to the MARS site. During communication with the MARS
site, the PC log window will display the message “Data sent to MARS.” if the update was
successfully sent to the MARS. If this message does not appear, the update was not received
at the MARS site and communication will have to be re-tried from the PC.
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4.8.1. Changing MARS Port from PC
Select “Tools” then “Site Manager” from the MDU screen. Provide the ADMINISTRATOR
password when prompted. On the Site Manager form, select the “change port” button and
enter the new port. On the next communication with the MARS site, the port will be
changed at the MARS site. Following this, the new port must be manually entered into the
Port text box for future communications with the MARS site.

4.8.2 Changing MARS TCP/IP Username and Password from PC
To change the TCP/IP username and password of the MARS site from the PC, the TCP/IP
username and password must first be changed or cleared at the PC (See 4.1 Setting Options
and 4.2 Entering Password information to review this process). Then on the next
communication with the MARS site, the new username and password will be reset.
Following this reset, the new username and password will automatically be used for
communications with the MARS site. Note: this process must be repeated for each MARS
site that the PC is to communicate with.

4.8.3 Enabling Auto-configuration from MARS to PC
If an auto-detect was performed at the MARS site via the front control panel, it is possible
to send this configuration information to the PC. This avoids the manual entry of the site’s
configuration at the PC. In order to accomplish this, follow these steps:

Immediately following an auto-detect performed at the MARS site, at the PC select
“Options…” from the Tools menu on the MDU screen. Under the "General" tab select
"Enable auto-configuration from MARS to PC”. Select “Save” then “Close”. Select the
MARS site on the Main Screen, then connect to the site by selecting the “Connect” button
or the “Dial MARS” button. The MARS site configuration will be received and stored at the
PC. After receiving the update, select  “Options…” from the Tools menu on the MDU
screen. Under the "General" tab de-select "Enable auto-configuration from MARS to PC”.
Select “Save” then “Close”.
NOTE: This auto-configuration can only take place following a manual auto-detect at the
MARS site. Once the PC has received the detected configuration from the MARS site, the
MARS site cannot update the PC with its configuration until another auto-detect is done at
the MARS site. This is to ensure that the PC’s configuration from this time on will update
the MARS site configuration so that it is identical to the PC’s configuration.

4.8.4 Changing the PC Port Number
To change the port that the PC uses to accept communication from the MARS site, ensure
that the database is opened then select “Tools” then “TCP/IP” Server. Beside the server
port, enter the new port number to be used (Note: the number must be between 21 and
65535, inclusive). To save the new port number, select “File” then “Save Server
Configuration”. Respond to the prompts to save the configuration and then close and restart
the MARS PC application. Once the application is restarted, the changes will take effect at
the PC. Now it is necessary to communicate with the MARS site to ensure that it gets
updated with the new port required to reach the PC. Reminder: all PC’s that the MARS site
contacts in the event of a fault must be using the same port.
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4.8.5 Re-enabling a Disabled MARS Site
A disabled MARS site is inhibited from automatically communicating faults to PC(s).
When the MARS site is in this state, it is still possible for a PC to communicate with the site
to monitor and configure the site.

The MARS site may be in a disabled state for two reasons: 1. It has been disabled on-site by
a technician (for example, while the technician is working on the monitored equipment) or
2. The site has reached the maximum daily transmissions specified at the PC in the Site
Manager Form.

If the MARS site has been disabled it can be re-enabled by clicking on the “Re-enable site”
checkbox in the Site Manager Form and then connecting to the MARS site to send this
request.

4.8.6 De-Activating the MARS site
When a MARS site is de-activated, it is fully disabled. The MARS site will not
automatically report faults or update status information on a PC that connects to it. To de-
activate a site, open the configuration window by selecting “MARS Configuration” from
the Tools menu on the MDU screen. Ensuring that the site to be de-activated is highlighted,
select the  "De-Activate Site" check box, then select "Close" to exit the configuration
window. "De-Activate Site" will appear in RED in the "Site Fault Status" frame on the
MDU screen.  The label will disappear after the MARS site has been de-activated. On
subsequent communications with the MARS site, the site will inform the PC that it is de-
activated. The PC will display a BLACK rectangle beside the disabled site in the site list
box on the MDU form.

Circumstances under which it may be desirable to de-activate a site:
1. There are frequent faults being reported due to unusual circumstances.
2. You wish to remove access to monitoring and control of the MARS site.
3. You wish to have the site inactive for a long term.
Compare this to a disabled MARS site. A disabled MARS site will automatically re-enable
after Midnight. A de-activated MARS site will not automatically re-activate at any time in
the future. A disabled MARS site can still provide status information to a PC that connects
to it, A de-activated MARS site cannot provide status information to a PC that connects to
it.

4.8.7 Re-Activating a MARS site
The steps to re-activate a MARS site are the same as those steps to activate the MARS site
on initial installation (See Item 4.7 Activating the MARS Site). Once those steps are taken,
it is necessary to connect to the MARS site in order for the PC to display whether the site is
re-activated. If the site was re-activated the rectangular display to the left of the site in the
site list should be RED or GREEN (RED in the case of a status fault at site, GREEN in the
case of no fault at site). If the site is not re-activated, the rectangular display beside the site
will remain BLACK.
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Appendix A – Calibration Graphs

Graph of MARS RF threshold values for CATV

0

50

100

150

200

250

35 33 31 29 27 25 23 21 19 17 15 13 11 9 7 5 3 1

RF Input (dBmV)

PC
 N

um
er

ic
 V

al
ue

30° Celsius 50° Celsius 10° Celsius



evsl MARS
Installation and Operation Manual

Ver 2.0 Printed in Canada
Page 29 of 31

Graph of MARS RF threshold values for QAM
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Appendix B - I2C cable assembly instructions
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Appendix C    MARS Specifications

Main Module Monitoring
CATV parameters RF, Video and Audio on Channels 2 to 125

Battery Backup
Type 6-volt (nominal) NiCAD pack
Charging Continous
Duration 30 to 90 minutes

Optional Sensing Devices
Temperature Maximum of 8 devices (-55 to 100 degrees Celsius)
Power Maximum of 8 devices (6 to 130 VAC/VDC)
Condition Maximum of 1 device (9 inputs total, 1 auxilliary output)

Remote Control Devices
Power Strip Maximum of 8 devices (8 outlets each)
Switch Maximum of 8 devices (8 terminals each)

Operating Temperature
Main Module 0 to 40 degrees C (32 to 104 degrees F)
Sensing Devices 0 to 50 degrees C (except for temperature module)

DC Power Input +9.2 VDC, 800ma

Mounting
Main Module Table top or rack mount
Sensing Devices Panel mount of wall bracket mount

Communication
Remote Ethernet/Analog Telephone Modem
Sensing Devices I2C Bus**

Dimensions
Mars Chassis 1.75”(h) x 17”(w) x 5”(d) (4.45 x 43.1 x 12.7 cm)

Connections
RF input I2C Bus** DC Input Jack
RJ45 Ethernet RJ11 Telephone Handset Jack
USB Port

** I2C: Inter-Integrated Circuit (a 2-wire bus specification developed by Philips Semiconductor)
Note: Specifications Subject to change
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